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Introduction 

This chapter provides basic information about Parallels® Transporter® and this User Guide. 

In This Chapter 
About Parallels Transporter .................................................................................................. 5 
About Parallels Transporter Agent........................................................................................ 6 
About This Guide.................................................................................................................. 6 
Getting Help.......................................................................................................................... 7 

 
 

About Parallels Transporter 
Parallels® Transporter® enables you to migrate selected volumes or the whole of a physical or 
virtual computer into a Parallels virtual machine or Parallels virtual disk. 

Parallels Transporter package includes two applications: 

 Parallels Transporter, and 
 Parallels Transporter Agent. 

The package should be installed both on host computer, to perform migration, and on physical 
source computer, to collect source system data and transfer it to the Transporter. 

Parallels Transporter supports the following operating systems: 

 Microsoft® Windows® (starting from Windows 2000) 
 Linux® 
 Mac OS® X 

For Windows and Linux operating systems, Parallels Transporter is provided as a separate 
application and supports three migration methods: local, remote and virtual. 

For Mac operating systems, Parallels Transporter is provided as a part of the Parallels Desktop 
package and supports two migration methods: remote and virtual. 

For more information about Parallels Transporter system requirements, see Host Computer 
System Requirements (page 8). 
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About Parallels Transporter Agent 
Parallels Transporter Agent is a Parallels Transporter utility installed together with Parallels 
Transporter and required to migrate from a physical computer with Windows or Linux operating 
system. Parallels Transporter Agent collects essential source system data and transfers it to 
Parallels Transporter for processing. 

The Parallels Transporter Agent supports a Microsoft® Windows® or Linux® operating system 
only. 

Before migration, you need to start the Agent if it doesn't start automatically.  

For information about Transporter Agent system requirements, see Source Computer System 
Requirements, Physical Computer (page 12). 
 

About This Guide 
This Guide is aimed at a wide range of users who want to use Parallels Transporter to migrate 
information from other physical computers and third-party virtual machines. The Guide 
provides both high-level concept descriptions and detailed step-by-step instructions to help you 
learn the product quickly and easily. 

Notation Conventions 

The table below presents the conventions used in this Guide. 

This font Used for buttons, options, menus and menu 
commands, windows, and dialog boxes. 

This font Used for keys, paths, and folder names. 

Fonts 

This font Used for glossary items. 

Note. Used to emphasize the message. Type Styles 

Warning. 
Used to warn you about possible data loss. 
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Getting Help 
Parallels Transporter offers several options for accessing necessary information: 

 Parallels Transporter User Guide. This document contains extensive information about the 
product, its usage and troubleshooting. The Guide is located in the Parallels Transporter 
folder. Default location is as follows: 
On Mac OS X: Applications/Parallels/ 

On Windows: C:\Program Files\Parallels\Parallels Transporter\ 

On Linux: /usr/share/doc/parallels-transporter 

 Help buttons. Click the  Help button at the bottom of the Transporter window to open a 
corresponding help page. 

 Parallels web site (http://www.parallels.com). Explore the Support web page that includes 
product help files and FAQ section. 

 

http://www.parallels.com/
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System Requirements 

This chapter lists system and network requirements. Before you start migrating, make sure that 
your host and source computers meet these requirements. If you are migrating locally, your 
computer must comply with both host and source computer requirements. 

In This Chapter 
Host Computer System Requirements .................................................................................. 8 
Source Computer System Requirements............................................................................... 11 
Network Requirements ......................................................................................................... 15 

 
 

Host Computer System 
Requirements 

Parallels Transporter can be installed on a host Macintosh, Windows or Linux computer. Your 
computer must comply with its system requirements listed in this section, so that Parallels 
Transporter can function properly. 
 

Mac OS X Computers 
On Macintosh computers, Parallels Transporter is installed automatically during Parallels 
Desktop installation. The following requirements are based on those for Parallels Desktop. 

Hardware Requirements 

Parallels Transporter hardware requirements are listed in the following table: 

Computer Intel-powered Core™ Duo or Core™ Solo Mac® Mini, iMac®, 
MacBook™, MacBook Pro or Mac Pro. 

System Memory 768 MB of RAM minimum. 

1 GB recommended. 

Free Hard Disk Space 40.5 MB required for Parallels Desktop. 

15 GB or more recommended for storing resulting virtual machines or virtual 
disks. 

Optical Drive CD-ROM and/or DVD-ROM drive. 

Network Device Ethernet adapter. 

FireWire adapter. 
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Software Requirements 

Parallels Desktop with Parallels Transporter supports Mac OS X 10.4.6 or later. 

To check your Mac OS X version number, choose Apple -> About This Mac from the  menu in 
the menu bar.  
 

Windows Computers 
On Windows computers, Parallels Transporter is installed as a separate application. Following 
are the system requirements for Parallels Transporter on Windows. 

Hardware Requirements 

Parallels Transporter hardware requirements are listed in the following table: 

Processor 700 MHz 32-bit processor with IA-32 compatibility (Intel Pentium or AMD 
Athlon). 

System Memory 768 MB of RAM minimum. 

1 GB recommended. 

Free Hard Disk Space 25 MB required for Parallels Transporter package. 

15 GB or more recommended for storing resulting virtual machines or virtual 
disks. 

Optical Drive CD-ROM and/or DVD-ROM drive. 

Network Device Ethernet adapter. 

or 

IEEE 1394 adapter. 

Note. Windows Vista does not support TCP/IP over IEEE 1394. 

Software Requirements 

Parallels Transporter supports the following Windows operating systems: 

 Windows Vista® Ultimate, Enterprise, Business 
 Windows Server® 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows XP Professional SP0, SP1,SP2 
 Windows XP Home  SP0, SP1,SP2 
 Windows 2000 Professional Edition 
 Windows 2000 Server 
 Windows 2000 Advanced Server 
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Linux Computers 
On Linux computers, Parallels Transporter is installed as a separate application. Following are 
the system requirements for Parallels Transporter on Linux. 

Hardware Requirements 

Parallels Transporter hardware requirements are listed in the following table: 

Processor 700 MHz 32-bit processor with IA-32 compatibility (Intel Pentium or AMD 
Athlon). 

System Memory 768 MB minimum. 

1 GB recommended. 

Free Hard Disk Space 25 MB required for Parallels Transporter package. 

15 GB or more recommended for storing resulting virtual machines or virtual 
disks. 

Optical Drive CD-ROM and/or DVD-ROM drive. 

Network Device Ethernet adapter. 
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Software Requirements 

Parallels Transporter supports the following Linux operating systems: 

 Red Hat® Enterprise Linux 5, 4, 3  
 Red Hat® Linux 9, 8, 7.3 
 Debian® Linux 4.0, 3.1 
 Fedora™ Core Linux  6, 5, 4, 3; Fedora™ 7 
 SUSE® Linux 10.2, 10.1, 10.0, 9.3, 9.2, 9.1, 9.0 
 Mandrake™ Linux 10.1, 10, 9.2 
 Mandriva Linux 2007 
 Ubuntu® Linux 7.04, 6.10, 6.06, 5.04 
 Xandros Busines 4.0 

To successfully install Parallels Transporter and its components, make sure you have the 
following software on your Linux computer: 

 GNU Compiler 4.0 or higher 
 GNU Make 3.8 or higher 
 kernel 2.6.14 source files or development package 
 glibc 2.3.6 
 glib2 2.10.3 
 glib 2.3.6 
 zlib 1.2.2.2 
 libstdc++ 4.0.2 
 libpng 1.2.8 

 
 

Source Computer System 
Requirements 

Parallels Transporter enables you to migrate from physical and virtual computers. Computers of 
each type must comply with specific system requirements. Before you start migrating, make 
sure that your source computer meets the requirements listed in this section. 
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Physical Computer 
To migrate from a physical computer, you need to start Parallels Transporter Agent. Transporter 
Agent collects information about the source computer and transfers it to Transporter for 
processing. 

Parallels Transporter Agent is installed simultaneously with Parallels Transporter on a source 
computer with a Windows or Linuxoperating system. Your computer must comply with the 
listed requirements, so that Transporter Agent can function properly. 

Hardware Requirements 

Parallels Transporter Agent hardware requirements are listed in the following table: 

Processor 32-bit processor with IA-32 compatibility (Intel Pentium or AMD Athlon). 

System Memory 256 MB 

Free Hard Disk Space 10 MB 

HDD Controllers IDE hard drive controllers. 

Network Device Ethernet adapter. 

or 

IEEE 1394 adapter. 

Note. Windows Vista doesn’t support TCP/IP over IEEE 1394. 

 



 System Requirements 13 
 

Software Requirements 

Parallels Transporter Agent supports the following Windows operating systems: 

 Windows Vista® Ultimate, Enterprise, Business 
 Windows Server® 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows XP Professional SP0, SP1,SP2 
 Windows XP Home  SP0, SP1,SP2 
 Windows 2000 Professional Edition 
 Windows 2000 Server 
 Windows 2000 Advanced Server 

Parallels Transporter supports the following Linux operating systems: 

 Red Hat® Enterprise Linux 5, 4, 3  
 Red Hat® Linux 9, 8, 7.3 
 Debian® Linux 4.0, 3.1 
 Fedora™ Core Linux 6, 5, 4, 3 
 SUSE® Linux 10.2, 10.1, 10.0, 9.3, 9.2, 9.1, 9.0 
 Mandrake™ Linux 10.1, 10, 9.2 
 Mandriva Linux 2007 
 Ubuntu® Linux 7.04, 6.10, 6.06, 5.04 
 Xandros Busines 4.0 

Supported File Systems 

Parallels Transporter Agent supports the following file systems: 

 FAT16/32 (Windows only) 
 NTFS (Windows only) 
 Ext2/Ext3 

If the file system is not supported, Transporter Agent copies all disk sectors successively. 
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Virtual Computer 
Parallels Transporter enables you to migrate from a Microsoft Virtual PC or VMware virtual 
machine or virtual disk to a Parallels virtual machine or virtual disk. The source computer or 
disk must meet the listed requirements. 

Supported Formats of Virtual Computer Files 

Parallels Transporter supports the following formats: 

 HDD by Parallels 
 VMWAREVM, VMDK, and VMX by VMware 
 VHD and VMC by Microsoft. 

Software Requirements 

Parallels Transporter supports the following operating systems: 

 Windows Vista® Ultimate, Enterprise, Business 
 Windows Server® 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows XP Professional SP0, SP1,SP2 
 Windows XP Home  SP0, SP1,SP2 
 Windows 2000 Professional Edition 
 Windows 2000 Server 
 Windows 2000 Advanced Server 

Parallels Transporter supports the following Linux operating systems: 

 Red Hat® Enterprise Linux 5, 4, 3  
 Red Hat® Linux 9, 8, 7.3 
 Debian® Linux 4.0, 3.1 
 Fedora™ Core Linux 6, 5, 4, 3 
 SUSE® Linux 10.2, 10.1, 10.0, 9.3, 9.2, 9.1, 9.0 
 Mandrake™ Linux 10.1, 10, 9.2 
 Mandriva Linux 2007 
 Ubuntu® Linux 7.04, 6.10, 6.06, 5.04 
 Xandros Busines 4.0 

Supported File Systems 

Parallels Transporter supports the following file systems: 

 FAT16/32 (Windows only) 
 NTFS (Windows only) 
 Ext2/Ext3 
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If the file system is not supported, Transporter copies all disk sectors successively. 
 

Network Requirements 
To migrate from a remote computer, you need to establish a network connection between the 
host and the source computers. The connection can be wireless or wired, through a network 
cable or FireWire. If you use a wired connection with default settings, Parallels Transporter 
automatically configures the connection settings. If you changed the default settings or use a 
wireless connection, you need to configure the settings manually. 

Note 1. Windows Vista does not support TCP/IP over IEEE 1394. 

Note 2. FireWire is not supported on Linux. 

For all connections, Parallels Transporter uses fixed ports in the range of 1620 to 1623. 
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Installing Parallels Transporter 

This chapter provides instructions on Parallels Transporter installation. 

 

In This Chapter 
Installing on Mac OS X......................................................................................................... 16 
Installing on Windows .......................................................................................................... 16 
Installing on Linux ................................................................................................................ 20 

 
 

Installing on Mac OS X 
For Macintosh computers, Parallels Transporter package is provided as a Parallels Desktop 
built-in feature and is installed automatically during Parallels Desktop installation. For detailed 
installation instructions, see Parallels Desktop for Mac User Guide. 
 

Installing on Windows 
For Windows computers, Parallels Transporter is provided as a separate application, and you 
need to install it manually. Parallels Transporter package contains Parallels Transporter and 
Parallels Transporter Agent (for remote migration). 

Note. You must have administrator rights to install the Parallels Transporter package. 
 

Parallels Transporter Download 
To install Parallels Transporter package for Windows, you need to download the latest package 
from Parallels web site (http://www.parallels.com). 

The package filename is Parallels-Tsp-3.0.XXXX-Win.exe, where XXXX stands for 
the build number. 
 

 

http://www.parallels.com/
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Parallels Transporter Installation 
Parallels Transporter package contains Parallels Transporter and Parallels Transporter Agent 
which are installed simultaneously during Parallels Transporter installation. 

To install Parallels Transporter and its components 

1 Open Parallels-Tsp-3.0.XXXX-Win.exe to start installation. 

The Parallels Transporter Setup Wizard displays the Welcome window. 

2 In the Welcome window, click Next. 
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3 In the Software License Agreement window, carefully read the End User License Agreement. 
Click the Print button to print the document. If you agree with the stated terms and 
conditions, select I accept the terms of the license agreement. Click Next.  

 
4 In the Choose Destination Location window, specify the Parallels Transporter destination 

folder. By default, the program is installed to C:\Program 
Files\Parallels\Parallels Transporter. To change the destination folder, 
click Change and browse to another location. Click Next. 
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5 In the Customize Parallels Transporter Installation window, choose where you want to place 
Parallels Transporter program shortcut(s). Click Next. 

 
6 The wizard is ready for installation. Click Install to start. 
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7 When installation is completed, you need to restart the computer. You can restart the 
computer right now or later. Choose the most convenient option and click Finish. 

 
 

Installing on Linux 
For Linux computers, Parallels Transporter package is provided as a separate application, and 
you need to install it manually. The Parallels Transporter package includes Parallels Transporter 
and Parallels Transporter Agent. Depending on migration method, you may install either the full 
package (for local migration) or Transporter Agent only (for remote migration). You can install 
Parallels Transporter package using the command line or the text user interface (TUI). For 
instructions, see Installing From Command Line (page 21), Installing From TUI (page 21) and 
Installer Options (page 22). 

Note. You must have root privileges to install the Parallels Transporter package or its 
components on Linux. 
 

Parallels Transporter Download 
To install Parallels Transporter for Linux, you need to download the latest package from 
Parallels web (http://www.parallels.com) site. 

The package filename is Parallels-Tsp-3.0.XXXX-lin.run, where XXXX stands for 
the build number. 

 
 

 

http://www.parallels.com/
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Installing From Command Line 
To install Parallels Transporter and/or its components from the command line, do the following: 

1 Download the latest package from Parallels web site (http://www.parallels.com).The 
package filename is Parallels-Tsp-3.0.XXXX-lin.run, where XXXX stands for 
the build number. 

2 Start the terminal and go down to the download directory. 

3 Start the Parallels Transporter installer by entering 
# sh Parallels-Tsp-3.0.XXXX-lin.run 

Note. You must have root privileges to install Parallels Transporter. 

4 As Parallels Transporter installer displays the Introduction, press Enter. 

5 Specify the action you want the installer to perform by pressing the corresponding key. 
Press 1 to install. 

6 Carefully read the License Agreement and enter Y to accept the stated terms and conditions. 

7 Choose if you want to install both Parallels Transporter and Parallels Transporter Agent or 
Parallels Transporter Agent only. Enter Y to install both, enter N to install Transporter Agent 
only. 

8 When the installation is complete, the installer informs you about it. 

 
 

Installing From TUI 
To install Parallels Transporter and/or its components from the TUI, do the following: 

1 Download the latest package from Parallels web site (http://www.parallels.com).The 
package filename is Parallels-Tsp-3.0.XXXX-lin.run, where XXXX stands for 
the build number. 

2 Start the terminal and go down to the download directory. 

3 Log in as root using su or sudo command. 

4 Start the Parallels Transporter installer by entering 
# sh Parallels-Tsp-3.0.XXXX-lin.run 

Note. You must have root privileges to install Parallels Transporter. 

5 As Parallels Transporter installer displays the Introduction, press Enter. 

6 Specify the action you want the installer to perform with the Up and Down keys. Press 
Enter. 

7 Carefully read the License Agreement; use the navigation keys to scroll though the 
document. Press Enter. 

8 Select Yes to accept the stated terms and conditions. Press Enter. 

9 Choose if you want to install both Parallels Transporter and Parallels Transporter Agent or 
Parallels Transporter Agent only. 

 

http://www.parallels.com/
http://www.parallels.com/
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10 When the installation is complete, the installer informs you about it. 

 

 
 

Installation Options 
You can install Parallels Transporter and its components in batch mode or during unattended 
installation. The following table lists the command-line options you can use. 

Options and Syntax Description 
-h, --help Show the installer help. 

-d, --debug <level> Debug level. Possible values are: 

0 - debug, don‘t print output; same as --silent 

1 - debug, print errors only 

2 - debug, print errors and warnings 

3 - debug, print errors, warnings and debug information 

-s, --silent Debug, don’t print output. 

-p, --prefix dir Set dir to be Parallels Transporter default directory. 

-k, --kversion 
<version_number> 

Build module(s) for the specified kernel version. 

-e, --accept-eula Accept the terms of the License Agreement. 

-a, --action <action> Perform specified action on target(s). Possible values are: 

install [--target <target_name>] - install target. If no 
target is specified, all three components are installed. 

uninstall [--target <target_name>] - uninstall target. If 
no target is specified, all three components are installed. 

-t, --target 
<target_name> 

Specify targets (components) to take actions on. Possible values 
are: 

agent - install/uninstall Parallels Transporter Agent 

transporter - install/uninstall Parallels Transporter 

kmod - build module(s) for the specified kernel 

-u, --user-interface 
<interface_value> 

Select interface. Possible values are: 

cmd - command line 

ncurses - dialog 

-w, --skip-welcome Skip introduction. 

-l, --log 
<log_file_name> 

Specify the file the installer will use for writing log information 
(by default, it is parallels-installer.log) 
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Following are some usage examples: 

1 To accept the terms of the License Agreement and install Parallels Transporter, enter the 
following: 

Parallels-Tsp-3.0.XXXX-lin.run --accept-eula --action install --target 
transporter 

2 To accept the terms of the License Agreement and install kernel module for kernel 2.6.20, 
enter the following: 

Parallels-Tsp-3.0.XXXX-lin.run --accept-eula --action install --target 
kmod --kversion 2.6.20 
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Uninstalling Parallels Transporter 

This chapter provides instructions on uninstalling Parallels Transporter and its components. 

In This Chapter 
Uninstalling on Mac OS X.................................................................................................... 24 
Uninstalling on Windows...................................................................................................... 24 
Uninstalling on Linux ........................................................................................................... 25 

 
 

Uninstalling on Mac OS X 
Parallels Transporter can be uninstalled only along with Parallels Desktop. See Parallels 
Desktop for Mac User Guide for instructions.  
 

Uninstalling on Windows 
Parallels Transporter can be uninstalled in two ways: 

 From the Start menu, choose Control Panel->Add or Remove Programs. In the program list, 
select Parallels Transporter and click Remove. 

or 

 Open the file Parallels-Tsp-3.0.XXXX-Win.exe. This will start the Setup Wizard 
that will remove the program. 

Note. You must have administrator rights to uninstall Parallels Transporter. 
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Uninstalling on Linux 
You can uninstall Parallels Transporter or its components on Linux either by using the installer 
(command-line or TUI) or command-line options. For the list of available options, see 
Installation Options (page 22). 

To uninstall Parallels Transporter or its components using the command-line version of the 
installer, do the following: 

1 Start the terminal and go down to the directory where you store the Parallels-Tsp-
3.0.XXXX-lin.run file. 

2 Start the Parallels Transporter installer by entering 
# sh Parallels-Tsp-3.0.XXXX-lin.run 

Note. You must have root privileges to uninstall Parallels Transporter. 

3 As Parallels Transporter installer displays the Introduction, press Enter. 

4 Specify the action you want the installer to perform by pressing the corresponding key. 
Press 2 to uninstall. 

5 Specify the components you want to uninstall: you can uninstall both Parallels Transporter 
and Parallels Transporter Agent or select only one component. 

Press 1 to uninstall Transporter Agent. 

Press 2 to uninstall Transporter. 

Press 3 to uninstall both. 

6 When the uninstall process is complete, the installer informs you about it. 
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Parallels Transporter Basics 

This chapter provides information about the basic concepts and procedures. 

In This Chapter 
Starting Parallels Transporter and Parallels Transporter Agent............................................ 27 
Accessing Product Information............................................................................................. 28 
Default Names and Locations ............................................................................................... 29 
Migration Modes................................................................................................................... 31 
Migration Source Type ......................................................................................................... 32 
Selecting Volumes for Migration.......................................................................................... 33 
Applying Hardware Changes to Operating System .............................................................. 34 
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Starting Parallels Transporter and 
Parallels Transporter Agent 

To start Parallels Transporter on Mac OS X 

In the Finder, open Applications -> Parallels. In the Parallels folder: 

 Double-click the Parallels Transporter icon . 

or 

 Start Parallels Desktop by clicking its icon and choose Import from the File menu. 

Warning. You must activate your copy of Parallels Desktop with an activation key 
(temporary or permanent) before you can use Parallels Transporter. 

To start Parallels Transporter or Parallels Transporter Agent on Windows 

From the Start menu, choose All Programs -> Parallels -> Parallels Transporter / Parallels 
Transporter Agent. 

To start Parallels Transporter or Parallels Transporter Agent on Linux 

In the command line, enter one the following: 
parallels_transporter 

or 
parallels_transporter_agent 

Note. You must have root privileges to start Parallels Transporter or Parallels Transporter 
Agent. 
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Accessing Product Information 
You can find basic product information, such as build number and trademarks in the About 
Parallels Transporter window. To open this window, start Parallels Transporter and do the 
following: 

On Mac OS X: From the Parallels Transporter menu, choose About Parallels Transporter. 

On Windows: Right-click the title bar and choose About Parallels Transporter. 

On Linux: In the command line, enter one of the following: 
parallels_transporter -v 

or 
parallels_transporter_agent -v 
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Default Names and Locations 
When running in Express mode, Parallels Transporter uses default naming and location settings. 

Parallels Transporter uses the following default paths: 

On Windows 

For virtual machines: 

C:\Documents and Settings\UserName\My 
Documents\Parallels\Parallels Virtual Machines\<folder name>\ 

For virtual disks:  

C:\Documents and Settings\UserName\My 
Documents\Parallels\Parallels Virtual Machines\Migrated Disks\ 

On Mac OS X 

For virtual machines: 

/Users/UserName/Documents/Parallels/<folder name>/ 

For virtual disks:  

/Users/UserName/Documents/Parallels/Migrated Disks/ 

Note. You can change the default path using the main Parallels Desktop menu. From the main 
menu, choose Preferences. Open the General tab and make your changes. The folder you 
specified will be used as the default one. 

On Linux 
For virtual machines: 

~/parallels-vm 

For virtual disks:  

~/parallels-vm 

The <folder name> value is assigned according to the migration source: 

 If you migrate from a physical computer, the folder is named after the source operating 
system. For example Microsoft Windows XP. 

 If you migrate from a virtual computer, the folder is named after the source virtual disk. For 
example, the source virtual disk XXX will be migrated to the XXX destination folder. 

Default names for configuration files and virtual disk files also differ depending on the 
migration source: 

If you migrate from a physical computer 
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 to a virtual machine, .pvs and .hdd files are named with the source OS short name. For 
example, winXP, vista, etc. 

 to a virtual disk, .hdd file is named with the source computer network name. 

If you migrate the entire virtual machine from a virtual computer 

 to a virtual machine, .pvs file is named with the source virtual computer name, and .hdd 
file is named with the source virtual hard disk name. 

 to a virtual disk, .hdd file is named with the source virtual hard disk name. 

If you migrate a single virtual hard disk from a virtual computer 

 to a virtual machine, .pvs file is named with the source OS short name, and .hdd file is 
named with the source virtual disk name. 

 to a virtual disk, .hdd file is named with the source virtual hard disk name. 

If the default location contains a file or folder with a particular name, all subsequent names will 
be assigned a number, for example, Microsoft Windows XP 1, Vista 1, Microsoft 
Windows XP 2,etc. 
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Migration Modes 
Parallels Transporter can run in two modes: Express and Advanced. The basic difference 
between the two is the degree of user control over the process. Advanced mode offers a more 
flexible environment, while Express mode enables you to concentrate on migration object, not 
on the migration method. 

Express Mode 

In Express mode, Parallels Transporter uses predefined settings to migrate from the active 
physical volume or virtual volume. By default, the Transporter applies hardware changes to the 
source operating system to make it bootable with Parallels virtual machine. If migration was 
completed successfully, Parallels Transporter creates two files: a virtual machine configuration 
file (.pvs) and a virtual disk file (.hdd). If Parallels Transporter can’t find the system files 
required for hardware changes, the source volume is migrated as a Parallels virtual disk.  

Destination folder and file names are predefined. For details, see Default Names and Locations 
(page 29). 

Advanced Mode 

In Advanced mode, Parallels Transporter uses user-defined settings. You can customize 
migration settings in the following way: 

 Select the specified remote or host source computer volumes you want to migrate. 
 Select the type of migration output: a bootable virtual machine or a virtual data disk. 
 Specify destination folder and resulting virtual machine or virtual disk name. 

Upon migration, Parallels Transporter creates several files depending on the desired migration 
output and specified source. For example, if you migrate from several source disks to a Parallels 
virtual machine, Parallels Transporter creates a virtual machine configuration file (.pvs) and 
several virtual disk files (.hdd). All virtual disks are accessible from the resulting virtual 
machine. 
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Migration Source Type 
Parallels Transporter for Windows and for Macintosh support different number of source types: 

On Windows: host computer, remote computer, virtual computer. 

On Linux: host computer, remote computer, virtual computer. 

On Mac OS X: remote computer, virtual computer. 

You can select the necessary migration source in the Migration Method window: 

 Select From this computer to migrate from the selected volumes of the host computer (local 
migration). 

 Select From another computer to migrate from the selected volumes of a remote physical 
computer. 

 Select From virtual computer to migrate from a VMware virtual machine or Microsoft 
Virtual PC. Using this option, you can also convert a Parallels or a third-party virtual disk to 
a bootable virtual machine, if the disk has an operating system on it. For details, see 
Processing Parallels Virtual Disks (page 88) and Migrating Single Virtual Disk (page 84). 

Note. If you want to migrate from the Boot Camp partition locally or remotely, choose 
accordingly From this computer or From another computer. 
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Selecting Volumes for Migration 
When migrating from a physical computer, host or remote, you can select which volumes to 
migrate in the Source Volumes window. Parallels Transporter supports migration from basic 
disks and partitions. 

The source volumes list contains information about the number of volumes, their type, file 
system, available disk space, etc. To select a volume, check the corresponding check box. Only 
volumes with supported file systems can be migrated to a Parallels virtual machine. See Source 
Computer System Requirements (page 11). 

 

If you select one or more volumes on a disk, Parallels Transporter will process the whole disk. 
In the resulting virtual machine, the volumes that were not selected are visible, but inaccessible. 

Note. Make sure that you have enough free hard disk space on your computer to allocate images 
of the selected volumes. Calculate the total space used by the selected volumes - you may need 
that much free space. 
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Applying Hardware Changes to 
Operating System 

To successfully migrate from a physical or virtual source computer to a bootable Parallels 
virtual machine, Parallels Transporter needs to apply hardware changes to the operating system 
on the source volume image. The hardware used for Parallels virtual machines differs from the 
source computer or virtual machine hardware. So, Parallels Transporter reads and modifies 
system files to make the operating system bootable. Parallels Transporter can apply hardware 
changes to existing Parallels virtual disks with an operating system installed and images of 
active source volumes, third-party virtual machines. 

The current version of Parallels Transporter provides this functionality for Windows and Linux 
operating systems only. For a complete list of supported operating systems, see Source 
Computer System Requirements (page 11).  

In Windows, to change hardware settings, Parallels Transporter browses the source system files 
for the necessary drivers. It recognizes source computer hardware and changes Hardware 
Abstraction Layer (HAL) and hard disk controller drivers. If Transporter can’t find the required 
drivers, it prompts you to either insert a CD/DVD with the installation files or specify the path 
to the source computer installation files folder. By default, the necessary files are located in 
<SystemRoot>\Driver Cache\i386. 

In Linux, you may apply the hardware changes by modifying configuration files, such as 
fstab. 

When the hardware change is completed, Parallels Transporter creates two files:  

 virtual machine configuration file (.pvs) required to run the machine on Parallels Desktop. 
By default, specific devices are replaced by generic devices available in a typical virtual 
machine. 

 bootable virtual hard disk (.hdd). 
 



 

C H A P T E R  6  

Working With Parallels Transporter 

This chapter provides typical Parallels Transporter usage scenarios, Parallels Transporter 
concepts description and detailed instructions on migration process. 

In This Chapter 
Typical Usage Scenarios ....................................................................................................... 35 
Migrating With Parallels Transporter ................................................................................... 41 

 
 

Typical Usage Scenarios 
There is a number of typical migration scenarios, for which you can use Parallels Transporter. 
The scenarios are defined by the purpose of migration. This section provides an overview of 
each migration scenario. For detailed instructions on how to accomplish the scenarios, see 
Migrating With Parallels Transporter (page 41). 
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Migrating Over Network (Remote Migration) 
If you want to experiment with the operating system or other software installed on a remote 
computer, use Parallels Transporter to quickly and easily migrate all source computer 
applications and data to a virtual machine on your Mac. In this scenario, you migrate directly 
from your source computer to your host Mac computer over a network or FireWire cable. 

Parallels Transporter enables you to migrate from a remote Windows or Linux computer to a 
Parallels virtual machine or a Parallels virtual disk (page 40). Transporter migrates data from 
the specified volume(s) of the source computer to newly created Parallels virtual disk files 
(.hdd) and creates a virtual machine configuration file (.pvs). These files constitute a ready-
to-use virtual machine with its hard and data disks. During remote migration, only the active 
volume is made bootable, and the resulting virtual machine has the same operating system that 
was active during migration. If Parallels Transporter can't identify the source operating system 
or you can't provide system installation files, all source volumes are migrated into Parallels 
virtual disks. 

Parallels Transporter enables you as well to migrate from a Boot Camp partition you have on a 
remote Mac computer to a bootable Parallels virtual machine or a Parallels virtual disk (page 
40). This process is much the same as the remote migration from a Windows computer. For 
details, see the Migrating From Boot Camp Partition (page 38) scenarios. 

Note. To ensure successful migration, check that your host and remote computer meet the 
system requirements (page 8). 

To migrate from a remote computer, install Parallels Transporter on the host and on the source 
computer. Connect the computers with a network or FireWire cable. Start Parallels Transporter 
on the host computer and Parallels Transporter Agent on the source computer and follow the 
wizard instructions. For details, see Migrating From Remote Computer (page 41). 

When migrating from a Boot Camp partition you have on a remote Mac computer, your first 
Mac is considered to be the host computer and your Boot Camp partition is considered to be the 
source computer. So, to migrate from this Boot Camp partition, you need to install Parallels 
Transporter on both computers: on the host computer (Mac) and on the source computer (Boot 
Camp). Connect the computers with a network or FireWire cable. Start Parallels Transporter on 
the host and Parallels Transporter Agent on the source computer and follow the wizard 
instructions. For details, see Migrating From Boot Camp Partition (page 53). 
 

 



 Working With Parallels Transporter 37 
 

Migrating Locally 
Parallels Transporter enables you to migrate your source computer applications and data to a 
virtual machine stored either on the source computer itself or on a removable storage device. 
You can then copy the resulting virtual machine to your Mac and use it with Parallels Desktop. 
This scenario is especially useful, if you want to experiment with the operating system or other 
software installed on your Windows or Linux computer, but cannot use network for migration.  

Parallels Transporter enables you to migrate from a Windows or Linux computer to a Parallels 
virtual machine or a Parallels virtual disk (page 40). Parallels Transporter migrates data from 
the specified volume(s) of the source computer to newly created Parallels virtual disk files 
(.hdd) and creates a virtual machine configuration file (.pvs). These files constitute a virtual 
machine with its hard and data disks. During remote migration, only the active volume is made 
bootable, and the resulting virtual machine has the same operating system that was active during 
migration. If Parallels Transporter can't identify the source operating system or you can't 
provide system installation files, all source volumes are migrated into Parallels virtual disks. 

Parallels Transporter enables you as well to migrate locally within the Boot Camp partition to a 
bootable Parallels virtual machine or a Parallels virtual disk (page 40). The process of this 
migration is much the same as the local migration from a Windows computer. For details, see 
the Migrating From Boot Camp Partition (page 38) scenarios. 

To be able to work with the resulting virtual machine in Parallels Desktop, you should open it in 
Parallels Desktop and change some of its configuration settings. In Configuration Editor, 
specify the path to the Parallels Tools image file and floppy disk image. Make sure that all the 
other setting fit your requirements. For more details, see What Next (page 92). 

Note. To ensure successful migration, check that your Windows or Linux computer meets both 
the source and the host computer system requirements (page 8). 

To migrate locally, install the Parallels Transporter package on your computer. Start Parallels 
Transporter and follow the wizard instructions. For details, see Migrating From Host Computer 
(page 73). 

To migrate locally within the Boot Camp partition, you should install Parallels Transporter on 
Boot Camp partition. Start Parallels Transporter and follow the wizard instructions. For details, 
see Migrating Within Boot Camp Partition (page 68). 
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Migrating From Boot Camp Partition 
With Parallels Transporter, you can migrate your Boot Camp partition to a bootable Parallels 
virtual machine or Parallels virtual disk (page 40). There are three  methods you can use when 
migrating from Boot Camp partition: 

 migrating within the Boot Camp partition (local migration), or  
 migrating via the Boot Camp virtual machine, or 
 migrating from the Boot Camp partition of a remote Mac (standard remote migration). 

Migrating Within Boot Camp Partition 

Migration within the Boot Camp partition is much the same as standard local migration. In this 
case, your Boot Camp partition is considered to be an ordinary Windows computer. So, if you 
migrate within the Boot Camp partition, Parallels Transporter migrates the partition to a newly 
created Parallels virtual disk file (.hdd), creates a virtual machine configuration file (.pvs), 
and stores them on the Boot Camp partition. The virtual hard disk and virtual machine 
configuration files constitute a virtual machine with its hard disk. So you can just copy the two 
files (.hdd and .pvs) to your Mac.  

To be able to work with the resulting virtual machine in Parallels Desktop, you should open it in 
Parallels Desktop and change some of its configuration settings. In Configuration Editor, 
specify the path to the Parallels Tools image file and floppy disk image. Make sure that all the 
other setting fit your requirements. For more details, see What Next (page 92). 

Note. To ensure successful migration, check that your Windows Boot Camp computer meets 
both the source and the host computer system requirements (page 8). 

To migrate according to this scenario, you need to boot into Windows OS on the Boot Camp 
partition and install Parallels Transporter. Start Parallels Transporter and follow the wizard 
instructions. For details, see Migrating Within Boot Camp Partition (page 68). 

Migrating via Boot Camp Virtual Machine 

Migration via the Boot Camp virtual machine is much the same as standard remote migration. If 
you migrate using the virtual machine, the Boot Camp partition is considered as a remote 
physical computer. In this case, Parallels Transporter migrates the Boot Camp partition to a 
newly created Parallels virtual disk file (.hdd) and a virtual machine configuration file (.pvs) 
on your Mac. These files constitute a ready-to-use virtual machine with its hard disk. 

For the information on how to create a Boot Camp virtual machine, refer to the corresponding 
topics in Parallels Desktop User Guide. 

Note. To ensure successful migration, check that your host and remote computer meet the 
system requirements (page 8). 

To migrate from the Boot Camp partition directly to your Mac, start your Boot Camp virtual 
machine and make sure that Parallels Transporter is installed on both computers: on the host 
computer (Mac partition) and on the source computer (Boot Camp partition). Start Parallels 
Transporter on the host computer and Parallels Transporter Agent on the source computer and 
follow the wizard instructions. For details, see Migrating via Boot Camp Virtual Machine (page 
61). 
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Migrating From the Boot Camp Partition of Remote Mac 

This migration is much alike the standard remote migration. When migrating from a Boot Camp 
partition you have on a remote Mac computer, your first Mac is considered to be the host 
computer and your Boot Camp partition is considered to be the source computer. According to 
this scenario, you can migrate the Boot Camp partition into a Parallels bootable virtual machine 
and store it on your Mac. For more details, see Migrating From Boot Camp Partition of Remote 
Mac (page 54). 

Note. To ensure successful migration, check that your host and remote computer meet the 
system requirements (page 8) and network requirements (page 15). 

To migrate from the Boot Camp partitionto your Mac, make sure that Parallels Transporter is 
installed on both computers: on the host computer (Mac partition) and on the source computer 
(Boot Camp partition). Start Parallels Transporter on the host computer and Parallels 
Transporter Agent on the source computer and follow the wizard instructions. For details, see 
Migrating From Boot Camp Partition of Remote Mac (page 54). 
 

Migrating From Third-Party Virtual Computer 
With Parallels Transporter, you can easily migrate from your Microsoft Virtual PC or VMware 
virtual machine or virtual disk to a bootable Parallels virtual machine or Parallels virtual disk 
(page 40). Parallels Transporter converts the third-party virtual machine files into Parallels 
format, leaving applications and data unchanged. During migration, Parallels Transporter 
creates a virtual machine configuration file (.pvs) and virtual disk files (.hdd). These files 
constitute a ready-to-use virtual machine and its hard and data disks. If Parallels Transporter 
can't identify the source operating system or you can't provide system installation files, all 
source volumes are migrated into Parallels virtual disks (page 40). 

You can also migrate a single Microsoft Virtual PC or VMware virtual disk to a bootable 
Parallels virtual machine, if the disk has an operating system installed. 

Note. To ensure successful migration, check that your host and virtual source computer meets 
the system requirements (page 8). 

To migrate from a third-party virtual machine or virtual disk, install Parallels Transporter on the 
host physical computer. Start the Transporter and follow the wizard instruction. For details, see 
Migrating From Virtual Computer (page 82). 
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Creating Parallels Virtual Data Disks 
Parallels Transporter enables you to migrate source physical or virtual volumes into Parallels 
virtual disks. You can then mount the resulting virtual disks on the existing Parallels virtual 
machine and use all source volume data. The only restriction is that the virtual disk file system 
must be compatible with the operating system installed on the virtual machine. 

To create a Parallels virtual disk, install the Parallels Transporter package on the host computer 
and on the source physical computer, remote or host. Start the Transporter and follow the 
wizard instructions. By default, Parallels Transporter attempts to migrate the source volume to a 
virtual machine. You need to select the Advanced mode to migrate it as a data disk. For detailed 
migration instructions, see Migrating From Remote Computer (page 41), Migrating From Host 
Computer (page 73) and Migrating From Virtual Computer (page 82). 
 

Converting Parallels Virtual Data Disks to Virtual Machines 
You can use Parallels Transporter to migrate an already existing Parallels virtual disk to a 
bootable Parallels virtual machine. The virtual disk must have an operating system on it, so that 
Parallels Transporter can apply the required hardware changes. During migration, Parallels 
Transporter creates a virtual machine configuration file (.pvs) and a virtual disk file (.hdd). 
These files constitute a ready-to-use virtual machine and its hard disk. 

Note. To ensure successful migration, check that your source virtual disk meets the system 
requirements (page 8). 

To convert a Parallels virtual disk to a bootable virtual machine, install Parallels Transporter on 
the host computer. Start the Transporter and follow the wizard instructions. For details, see 
Processing Parallels Virtual Disks (page 88). 
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Migrating With Parallels Transporter 
This chapter provides detailed instructions for different migration scenarios. 

In This Chapter 
Migrating From Remote Computer....................................................................................... 41 
Migrating From Boot Camp Partition ................................................................................... 53 
Migrating From Host Computer............................................................................................ 73 
Migrating From Virtual Computer........................................................................................ 82 

 
 

Migrating From Remote Computer 
Parallels Transporter enables you to migrate from selected volumes of a remote Windows or 
Linux computer to a Parallels virtual machine or virtual disk. During migration, Parallels 
Transporter creates virtual machine hard disk file (.hdd) and configuration file (.pvs) and 
applies all necessary changes to the source operating system to make it bootable with Parallels 
virtual machine. 

Source and host computers must meet the system requirements (page 8). 

Note. If you are migrating to host Windows computer with FAT16 or FAT32 file system, the 
resulting .hdd file size cannot exceed 2 GB or 4 GB respectively. 

Both on Windows and on Linux, Parallels Transporter creates an old-format .hdd file. Before 
you can use this file with Parallels Desktop, you need to convert it to the new format. To do this, 
open the file with Parallels Desktop and follow the instructions. 
 

Migrating in Express Mode 

In Express mode, you can migrate only the active volume of the remote source computer using 
predefined settings. By default, the active volume is migrated to a bootable virtual machine. If 
an error occurs, the volume is migrated to a Parallels virtual disk (.hdd).  

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from a remote computer in Express mode 

1 Turn on the host and the source computers and log in. Make sure that the computers are 
connected by a network cable. 

2 On the source computer, start Parallels Transporter Agent. 

3 On the host computer, start Parallels Transporter. 

To start the application on a host Macintosh computer, choose File ->Import from the main 
Parallels Desktop menu. 
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Parallels Transporter wizard starts and displays the Introduction window.  

4 In the Introduction window, click Next. 

 
5 In the Migration Mode window, select Express and click Next. 
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6 In the Migration Method window, select the computer you want to migrate from. To migrate 
from a remote source computer, select From another computer and click Next. 

 
7 Read the checklist in the Preparing for Migration window and make sure that you are ready 

for migration. When finished, click Next. 

 
8 In the Connection Type window, specify the connection you use. Click Next. 
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Note.  FireWire cannot be used for migrating from Linux remote computers. 

 
9 In the Migration Source window, choose the source computer. You can either select it from 

the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using the following data 
and type the source computer IP address in the input field. Click Next. 

 
Parallels Transporter starts migration. 

10 If Parallels Transporter can’t identify the operating system on the source volume, it will 
prompt you to specify the operating system.  
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11 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable with Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. On 
Windows, to specify the local path, click More Options and select Other location. You can 
either type the path to the files (usually located in the i386 folder) or click the Browse 
button to locate the folder. 

When finished, click Next. 

Note. If you are migrating from a Linux remote computer, go to the next step. 

 
The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;   - idle, migration interrupted or completed. 

12 Parallels Transporter informs you about successful migration with the Migration is 
Completed window. Click Finish to exit the Transporter. 
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Note. On Linux, Parallels Transporter informs you about the path to the resulting files. 

 
 

Migrating in Advanced Mode 

In Advanced mode, you can select from which volumes of the remote source computer to 
migrate and manage migration settings. You can migrate from both active and inactive volumes 
of the computer to a Parallels virtual machine or a virtual disk. 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from a remote computer in Advanced mode 

1 Turn on the host and the source computers and log in. Make sure that the computers are 
connected by a network cable. 

2 On the source computer, start Parallels Transporter Agent. 

3 On the host computer, start Parallels Transporter. 

To start the application on a host Macintosh computer, choose File ->Import from the main 
Parallels Desktop menu. 

Parallels Transporter wizard starts and displays the Introduction window.  
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4 In the Introduction window, click Next. 

 
5 In the Migration Mode window, select Advanced and click Next. 
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6 In the Migration Method window, select the computer you want to migrate from. To migrate 
from a remote source computer, select From another computer. Click Next. 

 
7 In the Connection Type window, specify the connection you use. Click Next. 

Note.  FireWire cannot be used for migrating from Linux remote computers. 
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8 Read the checklist in the Preparing for Migration window and make sure that you are ready 
for migration. When finished, click Next. 

 
9 In the Migration Source window, choose the source computer. You can either select it from 

the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using the following data 
and type the source computer IP address in the input field. Click Next. 

 
10 In the Source Volumes window, select the volumes you want to migrate. Click Next. 

 If you selected an active volume with operating system, Hardware Change window 
appears. 
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 If you selected an inactive volume, Destination Folder window appears. In this case, go 
to step 13. 

 
11 In the Hardware Change window, choose if you want to migrate to a bootable virtual 

machine or to a data disk. 

 Select Boot from it to create a virtual machine with a bootable operating system. 

 Select Use data from it to save the resulting Parallels virtual disk as a data disk. 

Click Next.  
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12 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable with Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. On 
Windows, to specify the local path, click More Options and select Other location. You can 
either type the path to the files (usually located in the i386 folder) or click the Browse 
button to locate the folder. 

When finished, click Next.  

Note. If you are migrating from a Linux remote computer, go to the next step. 

 
13 If you selected Boot from it, specify the name and destination for the resulting Parallels 

virtual machine in the Virtual Machine Name window. 

If you selected Use data from it, specify destination folder in the Destination Folder window. 
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Click Next.  

 
14 Review the specified parameters in the Migration Options window and make sure that all the 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

 
The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;    - idle, migration interrupted or completed. 
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15 Parallels Transporter informs you about successful migration with the Migration is 
Completed window. Click Finish to exit the Transporter. 

Note. On Linux, Parallels Transporter informs you about the path to the resulting files. 

 
 

Migrating From Boot Camp Partition 
Using Parallels Transporter you can migrate your Boot Camp partition locally or remotely to a 
bootable Parallels virtual machine or Parallels virtual disk (page 40) and store it either on your 
Mac or on the Boot Camp partition. 
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Migrating From Boot Camp Partition of Remote Mac 

Migration from the Boot Camp partition belonging to a remote Mac is much the same as the 
standard remote migration between two computers and proceeds under the same Parallels 
Transporter migration modes. 

Parallels Transporter supports two migration modes: Express mode and Advanced mode. 
Express migration mode enables you to quickly convert your Boot Camp partition to a Parallels 
virtual machine and to store it in the default location of your Mac. In this mode, Parallels 
Transporter uses predefined settings, and you need to provide only the most essential 
information. Advanced migration mode enables you to customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in Express mode, Parallels Transporter uses the default destination folder and doesn't 
prompt you to check the parameters. That is why only instructions on Advanced migration are 
given. 

To migrate from a remote computer in Advanced mode 

1 Turn on the host Mac computer and log into the source Boot Camp partition. Make sure that 
the computers are connected by a network cable. 

2 On the Boot Camp partition (source computer), start Parallels Transporter Agent. 

3 On your Mac (host computer), start Parallels Transporter by choosing File ->Import from the 
main Parallels Desktop menu. 

Parallels Transporter wizard starts and displays the Introduction window.  

4 In the Introduction window, click Next. 
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5 In the Migration Mode window, select Advanced and click Next. 

 
6 In the Migration Method window, select the computer you want to migrate from. To migrate 

from a remote source computer, select From another computer. Click Next. 
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7 In the Connection Type window, specify the connection you use. Click Next. 

 
8 Read the checklist in the Preparing for Migration window and make sure that you are ready 

for migration. When finished, click Next. 
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9 In the Migration Source window, choose the source computer. You can either select it from 
the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using the following data 
and type the source computer IP address in the input field. Click Next. 

 
10 In the Source Volumes window,  make sure that the Boot Camp partition is selected. Click 

Next. 

Note. The Source Volumes list doesn't include the Mac OS partition. 
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11 In the Hardware Change window, choose if you want to migrate to a bootable virtual 
machine or to a data disk. 

 Select Boot from it to create a virtual machine with a bootable operating system. 

 Select Use data from it to save the resulting Parallels virtual disk as a data disk. 

Click Next.  

 
12 Parallels Transporter reads and modifies the system files to make the operating system on 

the image bootable with Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. To specify 
the local path, click More Options and select Other location. You can either type the path to 
the files (usually located in the i386 folder) or click the Browse button to locate the folder. 
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When finished, click Next.  

 
13 If you selected Boot from it, specify the name and destination for the resulting Parallels 

virtual machine in the Virtual Machine Name window. 

If you selected Use data from it, specify destination folder in the Destination Folder window. 

Click Next.  
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14 Review the specified parameters in the Migration Options window and make sure that all the 
settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

 
The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;    - idle, migration interrupted or completed. 

15 Parallels Transporter informs you about successful migration with the Migration is 
Completed window. Click Finish to exit the Transporter. 
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Migrating via Boot Camp Virtual Machine 

Migration via the Boot Camp virtual machine is much alike the standard remote migration and 
proceeds under the same Parallels Transporter migration modes. 

Parallels Transporter supports two migration modes: Express mode and Advanced mode. 
Express migration mode enables you to quickly convert your third-party virtual machine to a 
Parallels virtual machine. In this mode, Parallels Transporter uses predefined settings, and you 
need to provide only the most essential information. Advanced migration mode enables you to 
customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in Express mode, Parallels Transporter uses the default destination folder and doesn't 
prompt you to check the parameters. That is why only instructions on Advanced migration are 
given. 

To migrate Boot Camp partition to a Parallels virtual machine in Advanced mode 

1 Launch the Boot Camp virtual machine and make sure it is connected to the same network 
as your Mac. 

2 On the Boot Camp virtual machine (source computer), start Parallels Transporter Agent. 

3 On your Mac (host computer), start Parallels Transporter. 

To start the application on the Mac computer, choose File ->Import from the main Parallels 
Desktop menu. 

Parallels Transporter wizard starts and displays the Introduction window.  

4 In the Introduction window, click Next. 
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5 In the Migration Mode window, select Advanced and click Next. 

 
6 In the Migration Method window, select the computer you want to migrate from. To migrate 

from a remote source computer, select From another computer. Click Next. 
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7 To migrate via VM, select Network Connection. Click Next. 

 
8 Read the checklist in the Preparing for Migration window and make sure that you are ready 

for migration. When finished, click Next. 
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9 In the Migration Source window, choose the source computer. You can either select it from 
the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using the following data 
and type the source computer IP address in the input field. Click Next. 

 
10 In the Source Volumes window, make sure that the Boot Camp partition is selected. Click 

Next. 

Note. The Source Volumes list doesn't include the Mac OS partition. 
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11 In the Hardware Change window, choose if you want to migrate to a bootable virtual 
machine or to a data disk. 

 Select Boot from it to create a virtual machine with a bootable operating system. 

 Select Use data from it to save the resulting Parallels virtual disk as a data disk. 

Click Next.  

 
12 Parallels Transporter reads and modifies the system files to make the operating system on 

the image bootable with Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. To specify 
the local path, click More Options and select Other location. You can either type the path to 
the files (usually located in the i386 folder) or click the Browse button to locate the folder. 
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When finished, click Next.  

 
13 If you selected Boot from it, specify the name and destination for the resulting Parallels 

virtual machine in the Virtual Machine Name window. 

If you selected Use data from it, specify destination folder in the Destination Folder window. 

Click Next.  
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14 Review the specified parameters in the Migration Options window and make sure that all the 
settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

 
The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;    - idle, migration interrupted or completed. 

15 Parallels Transporter informs you about successful migration with the Migration is 
Completed window. Click Finish to exit the Transporter. 
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Migrating Within Boot Camp Partition 

Migration within Boot Camp partition is much the same as the local migration and proceeds 
under the same Parallels Transporter migration modes. 

Parallels Transporter supports two migration modes: Express mode and Advanced mode. 
Express migration mode enables you to quickly convert your Boot Camp partition to a Parallels 
virtual machine stored on your Boot Camp partition. In this mode, Parallels Transporter uses 
predefined settings, and you need to provide only the most essential information. Advanced 
migration mode enables you to customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in Express mode, Parallels Transporter uses the default destination folder and doesn't 
prompt you to check the parameters. That is why only instructions on Advanced migration are 
given. 

To be able to work with the resulting virtual machine in Parallels Desktop, you should open it in 
Parallels Desktop and change some of its configuration settings. In Configuration Editor, 
specify the path to the Parallels Tools image file and floppy disk image. Make sure that all the 
other setting fit your requirements. For details, see What Next (page 92). 

To locally migrate Boot Camp partition in Advanced mode 

1 Boot into the Windows OS on your Boot Camp partition. 

2 Start Parallels Transporter by selecting Start -> Program Files -> Parallels -> Parallels 
Transporter. 
Parallels Transporter wizard starts. 

3 In the Introduction window, click Next. 
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4 In the Migration Mode window, select Advanced and click Next. 

 
5 In the Migration Method window, select the computer you want to migrate from. To migrate 

your Boot Camp partition locally, select From this computer and click Next. 

 
6 In the Source Volumes window, make sure that the Boot Camp partition is selected. Click 

Next. 
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Note. The Source Volumes list doesn't include the Mac OS partition. 

 
7 In the Hardware Change window, choose if you want to migrate to a bootable virtual 

machine or to a data disk. 

 Select Boot from it to create a virtual machine with a bootable operating system. 

 Select Use data from it to save the resulting Parallels virtual disk as a data disk. 

Click Next. 
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8 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable in Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to the installation files. To specify the 
local path, click More Options and select Other location. You can either type the path to the 
files (usually located in the i386 folder), or click the Browse button to locate the folder. 

When finished, click Next. 

 
9 If you selected Boot from it, specify the name and destination for the resulting Parallels 

virtual machine in the Virtual Machine Name window. 

If you selected Use data from it, specify destination folder in the Destination Folder window. 
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Click Next. 

 
10 Review the specified parameters in the Migration Options window and make sure that all 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

 
11 Parallels Transporter informs you about successful migration with the Migration is 

Completed window. Click Finish to exit Parallels Transporter. 
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Note. The files of the resulting virtual machine are located on the Boot Camp partition. To 
start working with this Boot Camp virtual machine, you should first transfer the newly 
created Parallels virtual disk file (.hdd) and the virtual machine configuration file (.pvs) 
to your Mac. 

 

 
 

Migrating From Host Computer 
Parallels Transporter enables you to migrate from selected volumes of your host Windows or 
Linux computer to a Parallels virtual machine or virtual disk. During migration, Parallels 
Transporter creates virtual machine hard disk file (.hdd) and configuration file (.pvs) and 
applies all the necessary changes to the source operating system to make it bootable with 
Parallels virtual machine. 

To be able to work with the resulting virtual machine in Parallels Desktop, you should open it in 
Parallels Desktop and change some of its configuration settings. In Configuration Editor, 
specify the path to the Parallels Tools image file and floppy disk image. Make sure that all the 
other setting fit your requirements. For more details, see What Next (page 92). 

Source and host computers must meet the system requirements (page 8). 

Note. If you are migrating to host Windows computer with FAT16 or FAT32 file system, the 
resulting .hdd file size cannot exceed 2 GB or 4 GB respectively. 

Both on Windows and on Linux, Parallels Transporter creates an old-format .hdd file. Before 
you can use this file with Parallels Desktop, you need to convert it to the new format. To do this, 
open the file with Parallels Desktop and follow the instructions. 
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Migrating in Express Mode 

In Express mode, you can migrate all volumes of the host computer in one session using 
predefined settings. By default, the active volume is migrated to a bootable virtual machine. If 
Parallels Transporter can't identify the source operating system or you can't provide system 
installation files, the volumes are migrated to a Parallels virtual disk (.hdd). 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from host Windows computer in Express mode 

1 Start Parallels Transporter. Select Start -> Program Files -> Parallels -> Parallels Transporter. 
Parallels Transporter wizard starts. 

2 In the Introduction window, click Next. 
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3 In the Migration Mode window, select Express and click Next. 

 
4 In the Migration Method window, select the computer you want to migrate from. To migrate 

locally, select From this computer and click Next. 

 
Parallels Transporter starts migration. 
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5 Parallels Transporter informs you about successful migration with the Migration is 
Completed window. Click Finish to exit Parallels Transporter. 

 
 

Migrating in Advanced Mode 

In Advanced mode, you can select which volumes of the host computer to migrate and manage 
migration settings. You can migrate both active and inactive volumes of the host computer to a 
Parallels virtual machine or a virtual disk. 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from host Windows computer in Advanced mode 

1 Start Parallels Transporter. Select Start -> Program Files -> Parallels -> Parallels Transporter. 
Parallels Transporter wizard starts. 
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2 In the Introduction window, click Next. 

 
3 In the Migration Mode window, select Advanced and click Next. 
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4 In the Migration Method window, select the computer you want to migrate from. To migrate 
locally, select From this computer and click Next. 

 
5 In the Source Volumes window, select the volumes you want to migrate. Click Next. 

 If you selected an active volume with an operating system installed, Hardware Change 
window appears. 

 If you selected an inactive volume, Destination Folder window appears. In this case, go 
to step 8. 
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6 In the Hardware Change window, choose if you want to migrate to a bootable virtual 
machine or to a data disk. 

 Select Boot from it to create a virtual machine with a bootable operating system. 

 Select Use data from it to save the resulting Parallels virtual disk as a data disk. 

Click Next. 

 
7 Parallels Transporter reads and modifies the system files to make the operating system on 

the image bootable in Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to the installation files. On Windows, to 
specify the local path, click More Options and select Other location. You can either type the 
path to the files (usually located in the i386 folder) or click the Browse button to locate the 
folder. 

When finished, click Next. 
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Note. If you are migrating from a Linux host computer, go to the next step. 

 
8 If you selected Boot from it, specify the name and destination for the resulting Parallels 

virtual machine in the Virtual Machine Name window. 

If you selected Use data from it, specify destination folder in the Destination Folder window. 

Click Next. 
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9 Review the specified parameters in the Migration Options window and make sure that all 
settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

 
10 Parallels Transporter informs you about successful migration with the Migration is 

Completed window. Click Finish to exit Parallels Transporter. 
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Migrating From Virtual Computer 
Parallels Transporter enables you to migrate not only from a physical computer, but also from a 
third-party virtual machine (VMware or Microsoft Virtual PC). As with physical computers, 
you can choose Express or Advanced migration mode and migrate the entire virtual machine or 
one of its disks. See Migrating Entire Virtual Machine (page 82) and Migrating Single Virtual 
Disk (page 84) for instructions. 

Besides migrating third-party virtual disks, Parallels Transporter enables you to convert the 
existing Parallels disk image files (.hdd) into Parallels virtual machines. See Processing 
Parallels Virtual Disks (page 88) for instructions. 

Both on Windows and on Linux, Parallels Transporter creates an old-format .hdd file. Before 
you can use this file with Parallels Desktop, you need to convert it to the new format. To do this, 
open the file with Parallels Desktop and follow the instructions. 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 
 

Migrating Entire Virtual Machine 

Parallels Transporter migrates a third-party virtual machine by converting the third-party 
configuration file and all hard disk files into Parallels virtual machine configuration file (.pvs) 
and hard disk files (.hdd). All data and configuration settings are preserved. 

Parallels Transporter supports two migration modes: Express mode and Advanced mode. 
Express migration mode enables you to quickly convert your third-party virtual machine to a 
Parallels virtual machine. In this mode, Parallels Transporter uses predefined settings, and you 
need to provide only the most essential information. Advanced migration mode enables you to 
customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in Express mode, Parallels Transporter uses the default destination folder and doesn't 
prompt you to check the parameters. That is why only instructions on Advanced migration are 
given. 

To migrate a third-party virtual machine in Advanced mode 

1 Start the Parallels Transporter on your physical computer. 

The Parallels Transporter wizard starts and displays the Introduction window. Click Next. 
2 In the Migration Mode window, select Advanced and click Next. 
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3 In the Migration Method window, choose the computer you want to migrate from. To migrate 
a third-party virtual machine, select From virtual computer and click Next. 

 
4 In the Source Data Type window, select the migration source type. To migrate the entire 

virtual computer with all its settings and hard disk information preserved, select Entire 
virtual computer. Click Next. 

 
5 In the Source Virtual Machine window, specify the virtual machine configuration file you 

want to migrate. Click the Browse button to locate the third-party virtual machine folder and 
select the necessary file. Click Next. 
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6 In the Destination Folder window, specify the folder where the new virtual machine files will 
be stored. Click Next. 

 
7 In the Migration Options window, check migration settings and make sure that all parameters 

are set correctly. You can go back and change the parameters if necessary. When finished, 
click Migrate. 

8 Parallels Transporter informs you about successful migration with the Migration is 
Completed window. Click Finish to exit Parallels Transporter. 

 

Migrating Single Virtual Disk 

Parallels Transporter migrates a third-party virtual disk by converting the third-party hard disk 
file into a Parallels hard disk file (.hdd) and creating a new virtual machine configuration file 
(.pvs). 

Parallels Transporter supports two migration modes: Express mode and Advanced mode. 
Express migration mode enables you to quickly convert your third-party virtual disk to a 
Parallels virtual machine or data disk (.hdd). In this mode, Parallels Transporter uses 
predefined settings, and you need to provide only the most essential information. Advanced 
migration mode enables you to customize migration settings. 

Express and Advanced migration is mostly similar, except that when migrating in Express 
mode, Parallels Transporter uses the default destination folder and doesn't prompt you to check 
the parameters. That is why only instructions on Advanced migration are given. 

To migrate a third-party virtual disk in Advanced mode 

1 Start the Parallels Transporter on your physical computer. 

The Parallels Transporter wizard starts and displays the Introduction window. Click Next. 

2 In the Migration Mode window, select Advanced and click Next. 
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3 In the Migration Method window, choose the computer you want to migrate from. To migrate a 
third-party virtual machine, select From virtual computer and click Next. 

 
4 In the Source Data Type window, select the migration source type. To migrate a single virtual 

disk to a newly created virtual machine, select Single virtual disk. Click Next. 

 
5 In the Source Virtual Disk Image window, specify the virtual machine hard disk file you want to 

migrate. 

Click the Browse button to locate the third-party virtual machine folder and select the 
necessary file. Click Next. 
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6 In the Destination Folder window, specify the folder where the new virtual disk files will be 
stored. Click Next. 

 
Parallels Transporter converts third-party hard disk file into a Parallels virtual disk file 
(.hdd). 

7 In the Hardware Change window, choose if you want to create a virtual machine using the 
resulting Parallels virtual disk file as a hard disk or use it as a data disk only. 

 Select Boot from it to create a virtual machine with a bootable operating system. 

 Select Use data from it to save the resulting Parallels virtual disk as a data disk. 
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8 If you chose Use Data from it, go to step 10. 

If you chose Boot from it, select the operating system to make bootable in the new virtual 
machine in the Hardware Changes to Operating System window. Click Apply. 
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9 Parallels Transporter reads and modifies the system files to make the operating system on an 
image bootable in Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to installation files. On Windows, to 
specify the local path, click More Options and select Other location. You can either type the 
path to the files (usually located in the i386 folder) or click the Browse button to locate the 
folder. 
When finished, click Next. 

 
10 Parallels Transporter informs you about successful migration with the Migration is Completed 

window. Click Finish to exit Parallels Transporter. 
 

Processing Parallels Virtual Disks 

Parallels Transporter enables you to convert the existing Parallels disk image file (.hdd) into a 
Parallels virtual machine by creating a configuration file (.pvs) and applying the necessary 
hardware changes to the operating system on the disk image. 

Parallels Transporter supports two migration modes: Express mode and Advanced mode. In 
Express mode, Parallels Transporter uses predefined settings, and you need to provide only the 
most essential information. Advanced migration mode enables you to customize migration 
settings. 

Express and Advanced migration is mostly similar, except that when migrating in Express 
mode, Parallels Transporter uses the default destination folder. That is why only instructions on 
Advanced migration are given. 

To  convert Parallels disk image into a virtual machine in Advanced mode 

1 Start the Parallels Transporter. 

The Parallels Transporter wizard displays the Introduction window. Click Next. 

2 In the Migration Mode window, select Advanced. Click Next. 
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3 In the Migration Method window, select From virtual computer. Click Next. 

 
4 In the Source Data Type window, select Single virtual disk. Click Next. 

5 In the Source Virtual Disk Image window, specify the Parallels disk image file (.hdd) you 
want to process. 

Click the Browse button to locate the necessary file. Click Next. 

 
Parallels Transporter collects information about the disk image. 
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6 In the Hardware Changes to Operating System window, select the operating system you want to 
make bootable in the new virtual machine. Click Apply. 

 
7 Parallels Transporter reads and modifies the system files to make the operating system on an 

image bootable in Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to installation files. On Windows, to 
specify the local path, click More Options and select Other location. You can either type the 
path to the files (usually located in the i386 folder) or click the Browse button to locate the 
folder. 
When finished, click Next. 
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8 In the Destination Folder window, specify the resulting virtual machine destination folder. 
Click Next. 

You can use an external USB drive folder as a destination one. By default, the destination 
folder gets the same name as the original virtual disk. 

In Express mode, Transporter uses the default destination folder and default name for the 
virtual machine. For more information, see Default Names and Locations (page 29). 

 
9 Parallels Transporter informs you about successful migration with the Migration is Completed 

window. Click Finish to exit Parallels Transporter. 
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What Next 

Now that you successfully completed migration, you can use the resulting files in your Parallels 
Desktop to work with newly created virtual machines. 

If you migrated locally on a Windows or Linux operating system, you need to transfer the 
resulting virtual machine or virtual disk to your Macintosh computer through a local network or 
with a removable storage device.  

To be able to work with the resulting virtual machine in Parallels Desktop, you should open it in 
Parallels Desktop and change some of its configuration settings: 

 Specify the path to the Parallels Tools image. 
1. In Configuration Editor, choose the CD/DVD-ROM option. 

2. Enable the Use image file option and locate the Parallels Tools image file. The default 
location is Mac HDD -> Library -> Parallels ->  Tools - vmTools.iso. 

 

 Connect the floppy disk image to your virtual machine. 
1. In Configuration Editor, choose the Floppy option. 

2. Connect a floppy disk image to your virtual machine by specifying the floppy disk 
image file name in the Image File field. 

 

 Check all the other settings and make sure that they fit your requirements. 

For information about Parallels virtual machine usage, see Parallels Desktop for Mac User 
Guide. 
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Troubleshooting and Limitations 

This chapter provides troubleshooting scenarios for the known issues. If you encountered an 
issue not described here, visit Parallels support team web page 
http://www.parallels.com/en/support/ or log us a support call. 

In This Chapter 
Installation Problems............................................................................................................. 93 
FireWire Connections ........................................................................................................... 93 
Firewall Settings ................................................................................................................... 94 
Source Operating System Detection ..................................................................................... 95 
Parallels Transporter unable to detect Transporter Agent..................................................... 95 
Migration Errors.................................................................................................................... 95 
Activation Problems.............................................................................................................. 96 
Reviving Applications........................................................................................................... 97 

 
 

Installation Problems 
If your host Windows Vista computer is not in the domain, it may refuse to restart automatically 
upon Transporter installation. In this case, you should restart it manually using the Shut Down -
>Restart command from the Windows Start menu. 
 

FireWire Connections 
If you experience problems with a FireWire connection, check the following: 

 Connection status: the connection must be enabled. 
 Firewall settings: make sure firewall doesn’t block the connection. See Firewall Settings 

(page 94) for details. 
 IP address: the IP address must be in the range of 169.254.0.1 to 169.254.254.254. 

To check the IP address, do the following: 

On Mac OS X 

1 From the Apple menu, choose System Preferences. 

2 In the System Preferences window, select Network. 

3 In the Network window, click the Ethernet tab to look up the IP address. 

 

http://www.parallels.com/en/support/
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On Windows 

1 From the Start menu, choose Control Panel -> Network Connections. 

2 From the list of available connections, select the one you want to check. Double-click the 
connection title. 

3 In the Status window, select the Support tab and look up the IP address. 
 

Firewall Settings 
Microsoft Windows XP, and Microsoft Windows Vista have built-in Firewall that blocks 
connections from and to other computers. When starting Parallels Transporter or Transporter 
Agent for the fist time, you may get the following message:   

 

Click the Unblock button to enable connection between Parallels Transporter and Parallels 
Transporter Agent. 

To prevent future blocking, add Transporter and Transporter Agent to the Firewall exceptions 
(the list of applications allowed to communicate through Firewall): 

1 From the Start menu, choose Control Panel->Network Connections. 

2 In the Network Tasks pane, click Change Windows Firewall Settings. 

3 Add Parallels Transporter and Transporter Agent to the Firewall exceptions list. 

Note. For additional information about Firewall blocking the connection, see Parallels 
Transporter unable to detect Transporter Agent (page 95). 
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Source Operating System Detection 
If Parallels Transporter detects the source operating system (Microsoft Windows  XP or 
Windows Vista computer) incorrectly, make sure that you don't use compatibility mode for any 
of the applications. 
 

Parallels Transporter unable to 
detect Transporter Agent 

To migrate remotely, you need to start Parallels Transporter on the host computer and Parallels 
Transporter Agent on the source computer. 

If Parallels Transporter fails to find Parallels Transporter Agent, it is most likely that built-in 
Mac Firewall blocks the connection with Parallels Agent. 

To  enable connection between Parallels Transporter and Parallels Transporter Agent and 
prevent further blocking, you should either turn off Firewall or add Transporter and Transporter 
Agent to the Firewall exceptions: 

1 From the Apple menu, choose System Preferences and select Sharing. 

2 In the Sharing window, choose the Firewall tab. 

3 Change the necessary settings. 

4 Now you can proceed with migration.  

If you try to search for Parallels Agent by typing the source computer IP-address manually, you 
will receive the message saying that Parallels Transporter Agent is being blocked. Click the 
Unblock button to enable connection between Parallels Transporter and Parallels Transporter 
Agent. 
 

Migration Errors 
This section provides solutions to some errors that may occur during the migration process. 

Migration doesn't start 

If you are migrating a remote Windows computer and the migration doesn't start, make sure that 
the snapman.sys driver is installed in C:\WINDOWS\system32\drivers\ . 

If the snapman.sys driver is not installed, follow these steps: 

1 Uninstall Parallels Transporter Agent. 

2 Restart your source Windows computer. 

3 Reinstall Parallels Transporter Agent. 
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4 Restart your source Windows computer again. 

5 Ensure that Parallels Transporter and Parallels Transporter Agent run properly, and try to 
migrate the source computer again. 

Migration is interrupted by an error 

Migration process can be interrupted by an error when you are trying to migrate a large volume 
to host Windows computer with FAT16 or FAT32 file system. On these file systems, the 
resulting .hdd file size cannot exceed 2 GB or 4 GB respectively. The resulting virtual disk file 
size equals to the size occupied by the data and software on the source computer. So before 
migrating, make sure the occupied space of the source volume(s) does not exceed 2 GB or 4 GB 
for host FAT16 or FAT32 file systems respectively. 

If migration from a source Windows computer was interrupted by an error, do the following 
before trying to migrate again: 

1 From the Start menu, choose My Computer. 
2 On the Hard Disk Drives pane, select the volume from which you want to migrate. Right-

click the volume and choose Properties.  

3 In the Properties pane, click the Tools tab and in the Error Checking section click the Check 
Now button.  

4 In the Check Disk window, select both options: Automatically fix file system errors and Scan 
for and attempt recovery of bad sectors. Click Start. 

5 Wait until the disk is scanned and errors are fixed. 

Dynamic volumes are not migrated 

Only basic volumes can be migrated. You cannot migrate dynamic volumes with Parallels 
Transporter. 

The only way to migrate the data stored on a dynamic disk is to copy this data to a basic disk on 
the host computer, and then to migrate this basic disk. 
 

Activation Problems 
If you migrate from Windows volumes to a bootable Parallels virtual machine, the operating 
system detects that the hardware changed and may required to re-activation. 
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Reviving Applications 
Applications that severely depend on specific hardware may not work in a virtual machine, 
because virtual machine hardware is different from hardware used on a source computer. 

If you migrated from several source volumes, the disk drive letters were changed. Make sure 
that the application paths are set correctly. If not, update them and see if the application works. 
If this didn't help, contact Parallels support. 
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Glossary 

Primary operating system (primary OS): Operating system that controls the I/O devices of the 
computer and that is loaded when the physical computer is turned on. 

Guest operating system (guest OS): Operating system that runs under the virtual machine 
control.  

Active operating system: The operating system, where Parallels Transporter Agent runs. 

Active volume: The volume of the physical source computer with an active operating system. 

Host computer: The computer you migrate to. 

Source computer: The computer that you are going to migrate from. On physical source 
computers, Parallels Transporter Agent must be installed. 
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